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Jeff Weeks’ computer program SnapPea has been used widely in 3-manifold topology. This program computes
hyperbolic structures after drillings and Dehn fillings on 3-manifolds, and it provides a variety of associated
topological, geometric and arithmetic invariants.
In our previous study about Seifert fibered Dehn surgeries on knots, we used SnapPea to investigate a

relationship between closed geodesics in hyperbolic knot complements and Seifert fibers after Seifert fibered
surgeries on them. We will explain how we used SnapPea in the study and propose some questions inspired by the
computer experiments. These experiments were carried out in the joint work with Katura Miyazaki while we were
preparing the paper [Miyazaki and Motegi, Comm. Anal. Geom., 7: 551–582].
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1. Introduction

Let K be a knot in the 3-sphere S3, with tubular neighborhood NðKÞ, and let EðKÞ ¼ S3 � intNðKÞ be the exterior of
K. Let � be a slope on @EðKÞ, i.e., the unoriented isotopy class of an essential simple loop on @EðKÞ. Let ðK; �Þ denote
the closed orientable 3-manifold obtained from S3 by �-Dehn surgery on K, in other words, the result of attaching a
solid torus V to EðKÞ so that � bounds a meridian disk of V (Fig. 1:1). Dehn surgeries on knots can be naturally
generalized to Dehn surgeries on links [25].

Using the preferred meridian-longitude pair of K � S3, we parameterize slopes � of K by r ¼ p
q
2 Q [ f1

0
g; then we

also write ðK; rÞ for ðK; �Þ. Note that ðK; 1
0
Þ ¼
 S3 and 1

0
-surgery is called a trivial surgery.

Note that H1ðEðKÞÞ is an infinite cyclic group generated by a meridian of K; a longitude of K is homologous to zero
in EðKÞ. Thus it is easy to see that H1ðK; pqÞ ¼
 Zjpj for any knot K. In particular, 1

n
-surgery on K yields a homology 3-

sphere for any integer n.
By Thurston’s uniformization theorem [24, 28] and the torus theorem [15, 17], knots in the 3-sphere are divided into

three classes: torus knots, satellite knots (i.e., a knot whose exterior contains a non-boundary-parallel, incompressible
torus), and hyperbolic knots (i.e., a knot whose complement admits a complete hyperbolic structure of finite volume).
Among these hyperbolic knots are the most important; and we empirically know that ‘most’ knots are hyperbolic.

Suppose that K is a hyperbolic knot. Then the set of exceptional surgeries E K ¼ fr j ðK; rÞ is not hyperbolicg is a
finite set [27, 28], and E K can be expressed as RK [ T K [S K [ C K , where
RK ¼ fr j ðK; rÞ is reducible, i.e., ðK; rÞ contains a 2-sphere not bounding a 3-ballg,
T K ¼ fr j ðK; rÞ is toroidal, i.e., ðK; rÞ contains an incompressible torusg,

gluing

back

remove

K

N(K) V

Fig. 1.1.
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S K ¼ fr j ðK; rÞ is Seifert fiberedg, and
C K ¼ fr j ðK; rÞ is a counter example to the geometrization conjectureg.
By definitionS K contains a trivial surgery 1

0
. The geometrization conjecture [28] and the cabling conjecture [9] state

that C K ¼ ; and RK ¼ ;, respectively. Therefore it is expected that E K ¼ T K [S K for any hyperbolic knot K.
The simplest knot satisfying T K 6¼ ; and S K 6¼ f1

0
g is the figure-eight knot, for which we have T K ¼ f0;�4g and

S K ¼ f1
0
;�1;�2;�3g [27].

See [10] and [18] for surveys on Dehn surgery on knots.
In [22] we studied Seifert fibered surgeries from the viewpoint of ‘‘locating Seifert fibers’’ and we reported some

experimental results obtained by using Weeks’ computer program SnapPea [30]. The experiments suggested an
interesting relationship between closed geodesics in hyperbolic knot complements and Seifert fibers after Seifert fibered
surgeries on them. The main purpose in this paper is demonstrating how we got the experimental results via SnapPea.

It should be mentioned that there are many researches in which SnapPea plays important roles, say [14, 20].
SnapPea is available at http://humber.northnet.org/weeks/index/SnapPea.html.
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2. How to Check Whether or Not a Given Knot or a Manifold Obtained by Dehn Surgery is Hyperbolic

We begin by demonstrating how to check whether or not a given knot is hyperbolic.

SnapPea Experiment 1 (Is a given knot hyperbolic?)
Let us check that the figure-eight knot K is hyperbolic.

(1) Choose New Link Projection in File menu (Picture 1:1). Then we have a window as in Picture 1:2.

(2) Draw a diagram of K using a mouse; at the beginning, we do not need to care about an over/under crossing
information (Picture 1:3).
To obtain the correct diagram of K, we invert some crossings by clicking on the crossing points as in Pictures 1:4
(before) and 1:5 (after).

(3) After correcting the diagram, click Complement button. Then we have a window as in Picture 1:6, which we call
the ‘‘Dehn filling’’ window. In the window, SnapPea displays that K is a hyperbolic knot with hyperbolic volume
2:029 . . . and H1ðEðKÞÞ ¼
 H1ðS3 � KÞ ¼
 Z.

SnapPea Experiment 2 (Is a Dehn surgered manifold hyperbolic?)
We continue to investigate whether or not resulting manifolds obtained by Dehn surgeries on the figure-eight knot K

are hyperbolic.

Picture 1.1.
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Picture 1.2.

Picture 1.3.

Picture 1.4.
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(1) To perform p
q
-surgery on K, we fill in the meridian box with p and fill in the longitude box with q in the ‘‘Dehn

filling’’ window. For instance, in Picture 2:1 we fill in the meridian-longitude boxes with 1 and 5 respectively and
then click Recompute button to get an information about the resulting manifold ðK; 1

5
Þ. Then SnapPea tells us that

the result is also a hyperbolic manifold with hyperbolic volume 1:918 . . ..
As we mentioned in Sect. 1, E K ¼ f1

0
; 0;�1;�2;�3;�4g for the figure-eight knot K.

What happens if the result is not hyperbolic?
(2) For instance, we perform �1-surgery on K, which can be done by filling in the meridian-longitude boxes with �1

and 1 respectively in the ‘‘Dehn filling’’ window as in Picture 2:2 and clicking Recompute button. Then as a
result SnapPea displays a message suggesting that ðK;�1Þ is a Seifert fiber space (or a solvable manifold) as in
Picture 2:2.

In Proposition 4:3, we will show that ðK;�1Þ is in fact a Seifert fiber space.

3. Dehn Surgery on Knots with Surgery Descriptions

In this section we will introduce a convenient method to investigate Dehn surgeries on (complicated) knots which
contain some ‘‘twisted parts’’ as in Fig. 3:1.

Let us consider a link K [ c described in Fig. 3:2.
Since � 1

n
-surgery on the trivial component c corresponds with n-twisting along the disk bounded by c, � 1

n
-surgery

on c yields S3 and Kn as the image of K. We say that Kn is obtained from K by n-twisting about c. So we can regard the

Picture 1.5.

Picture 1.6.
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Picture 2.1.

Picture 2.2.
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Fig. 3.1.

C

K

Fig. 3.2.

Experimental Study of Seifert Fibered Dehn Surgery via SnapPea 99



link K [ c with � 1
n
-surgery on c as Kn. More generally, by inserting trivial components c1; . . . ; cm, we can describe a

knot with m twisted parts. Such a description of the knot Kn is called a surgery description of Kn.

SnapPea Experiment 3 (Surgery descriptions of knots)
Let K [ c be the link given by Fig. 3:2. In this experiment we consider a knot obtained from the figure-eight knot by

twisting about c.
(1) We insert the trivial knot c (the blue circle) as in Picture 3:1; first we do not care about an over/under crossing

information and after closing the (blue) circle, by clicking on some crossing points, we convert the crossings to
obtain the desired link K [ c (Picture 3:2).

(2) After drawing the diagram, click Complement button so that we have the ‘‘Dehn filling’’ window (Picture 3:3).
Then SnapPea shows that the link K [ c is again hyperbolic.

(3) For instance, to obtain K3, the knot obtained from K by 3-twisting about c, we perform � 1
3
-surgery on c. This can

be done by filling in the meridian-longitude boxes in the second row with 1 and �3 respectively as in Picture 3:4
and clicking Recompute button. Then SnapPea displays a message showing that the knot K3 is also a hyperbolic
knot with hyperbolic volume 5:114 . . ..

Let us consider Dehn surgeries on knots Kn given by surgery descriptions. To perform p
q
-surgery on Kn correctly, we

need to consider the effect of the twisting on the surgery coefficient.

Picture 3.1.

Picture 3.2.
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Proposition 3.1 ([25]). Let K [ c be a link in S3 such that c is a trivial knot. Let Kn be a knot obtained from K by n-
twisting about c. Then the manifold obtained by p

q
-surgery on K and � 1

n
-surgery on c is homeomorphic to the result of

p
q
þ n½‘kðK; cÞ�2-surgery on Kn, where ‘kðK; cÞ denotes the linking number of K and c.

SnapPea Experiment 4 (Surgery on knots with surgery descriptions)
We start with Picture 3:4; recall that K is the red component and c is the blue component.

(1) Compute the linking number of K and c, see [25, Chapt. 5]. In our example ‘kðK; cÞ ¼ 2 with suitable orientations
of K and c; the choice of their orientations is irrelevant because we need the square of the linking number, see
Proposition 3:1.

(2) For instance, we perform 2-surgery on K3. Then the required surgery coefficient on K is p
q
¼ 2� 3� 22 ¼ �10

(Proposition 3:1). Thus we fill in the meridian-longitude boxes in the first row with �10 and 1 respectively and
click Recompute button (Picture 4:1). Then SnapPea shows that the result ðK3; 2Þ is a hyperbolic manifold with
hyperbolic volume 4:955 . . . and H1ððK3; 2ÞÞ ¼
 Z2 (Picture 4:1).

In practice, when we study knots obtained from a simpler knot by twistings about a trivial knot and surgeries on
them, the above method is quite useful.

Exercise. Check that � 23
327

-surgery on K2002 produces a hyperbolic 3-manifold via SnapPea.

Picture 3.3.

Picture 3.4.
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4. Which Curves in Knot Complements become Fibers after Seifert Fibered Surgeries?

This section is based on the joint work with Katura Miyazaki [22] in which we studied Seifert fibered surgeries from
the view point of ‘‘locating Seifert fibers’’.

Question 1. Suppose that ðK; rÞ is a Seifert fiber space. If a fiber in ðK; rÞ is contained in S3 � intNðKÞ, then it can be
regarded as a knot in S3. Which knot c in S3, then, becomes a fiber in ðK; rÞ?

To get a feel we start with some examples.

Example (Seifert fibered surgeries on torus knots). Let K be a torus knot on the boundary of an unknotted solid
torus in S3, and let c be the core of the solid torus. If ðK; rÞ is a Seifert fiber space, it admits a Seifert fibration in which
the trivial knot c is a fiber in ðK; rÞ.

Example (Seifert fibered surgeries on satellite knots). Let K be a satellite knot such that ðK; rÞ is Seifert fibered. If
�1ððK; rÞÞ is finite or ðK; rÞ is non-simple, then [2] or [21], respectively shows that a torus knot is a companion of K; the
Seifert fibration of the torus knot exterior extends over ðK; rÞ. Thus, as in Example above a trivial knot in S3 becomes a
fiber in ðK; rÞ.

In these examples, there is a natural answer to Question 1. Thus we are interested in Question 1 for Seifert fibered
surgeries on hyperbolic knots.

Example (Seifert fibered surgeries on the figure-eight knot). Let K be the figure-eight knot. Then ðK; rÞ is a Seifert
fiber space if and only if r ¼ 1

0
;�1;�2;�3. In Table 1, S2ðm1;m2;m3Þ denotes a Seifert fiber space over S2 with three

exceptional fibers of indices m1, m2 and m3.

We will show that the trivial knot c1 in Fig. 4:1 becomes an exceptional fiber in some Seifert fibration of ðK; rÞ for
r ¼ �1;�2;�3. The trivial knot c2 also has this property.

SnapPea Experiment 5 (Seifert fibered surgeries on the figure-eight knot I)
(1) Following SnapPea Experiment 1 (1) (2), we draw the diagram of K [ c1 as in Picture 5:1.
(2) After drawing the diagram, click Complement button. Then fill in the meridian-longitude boxes in the second

row with 1 and 0 respectively, and then click Recompute button to recover the figure knot complement

Picture 4.1.

Table 1. Exceptional surgeries on the figure-eight knot

r ¼ 1
0

r ¼ �1 r ¼ �2 r ¼ �3

ðK; rÞ S3 Seifert Seifert Seifert

S2ð2; 3; 7Þ S2ð2; 4; 5Þ S2ð3; 3; 4Þ
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(Picture 5:2). On the picture SnapPea shows that the figure eight knot is a hyperbolic knot with hyperbolic volume
2:029 . . ..

(3) To perform �1-surgery on K, we fill in the meridian-longitude boxes in the first row with �1 and 1 respectively
as in Picture 5:3 and click Recompute button. Then SnapPea suggests that the result is not hyperbolic, compare
with Picture 2:2.
To recognize that ðK;�1Þ is a Seifert fiber space, we need a proper proof. Later in Proposition 4:3 we will give a
proper proof of the fact that ðK;�1Þ is a Seifert fiber space over S2 with three exceptional fibers of indices 2, 3
and 7, and hereafter we assume this fact.

(4) How to check that c1 becomes a fiber in ðK;�1Þ via SnapPea.
We need the following fact.

Lemma 4.1. Let K be an arbitrary knot in S3. Suppose that ðK; rÞð6¼
 S2 � S1Þ is a Seifert fiber space and c is a knot in
ðK; rÞ. If ðK; rÞ � intNðcÞ is Seifert fibered, then ðK; rÞ admits a Seifert fibration so that c is a fiber.

Proof of Lemma 4:1. Since ðK; rÞ 6¼
 S2 � S1 (by the assumption) and ðK; rÞ 6¼
 RP3]RP3 for homological reason, by
[16, Lemma VI.7], ðK; rÞ is irreducible.

If the meridian of NðcÞ is not a fiber in the Seifert fibration of ðK; rÞ � intNðcÞ, then we can extend it to a Seifert
fibration of ðK; rÞ so that c is a fiber as desired. So in the following we assume that the meridian is a fiber in the Seifert
fibration of ðK; rÞ � intNðcÞ.

If the base orbifold B of ðK; rÞ � intNðcÞ is a disk with at most one cone point, then ðK; rÞ � intNðcÞ is a solid torus.
Then by changing the Seifert fibration so that the meridian of NðcÞ is not a fiber, we reduce to the above situation.
Otherwise, we have a properly embedded arc in B which does not cut off a disk without cone points. This implies that
ðK; rÞ is reducible, a contradiction. �

c2

c1

K

Fig. 4.1.

Picture 5.1.
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In Lemma 4:1, if a Seifert fibration of ðK; rÞ is unique up to isotopy, then we can isotope the Seifert fibration of ðK; rÞ
so that c becomes a fiber.
(5) To drill out c1 from ðK;�1Þ, we delete 1 and 0 from the second row as in Picture 5:4 and click Recompute

button. Then SnapPea suggests that the result is Seifert fibered (or possibly solvable).
(6) Choose Fundamental Group in View menu as in Picture 5:5.

Then SnapPea computes the fundamental group G ¼ �1ððK;�1Þ � c1Þ ¼
 �1ððK;�1Þ � intNðc1ÞÞ and gives us the
following presentation (Picture 5:6):

G ¼ ha; b j a2b3 i:

From the presentation we see that a2 ¼ b�3 belongs to the center of G. Furthermore, a2 ¼ b�3 generates an
infinite cyclic normal subgroup of G. For otherwise, ða2Þn ¼ ðb�3Þn ¼ 1 for some integer n > 0 and the
abelianization of G would be a finite group, a contradiction. Since ðK;�1Þ is assumed to be Seifert fibered over S2

with three exceptional fibers, it is irreducible [16, Example VI.13]. Thus if ðK;�1Þ � intNðc1Þ is reducible, then
there is a 3-ball in ðK;�1Þ containing c1 in its interior, and hence ðK;�1Þ � intNðc1Þ ¼
 ðK;�1Þ]ðS3 � intNðc1ÞÞ.
This implies that G is a free product of two nontrivial groups. Since the center of the free product of any two
nontrivial groups consists of the identity element alone, we should have a2 ¼ b�3 ¼ 1 in G, a contradiction. It
follows that ðK;�1Þ � intNðc1Þ is an irreducible 3-manifold with infinite cyclic normal subgroup. Apply the
following characterization theorem to conclude that ðK;�1Þ � intNðc1Þ is Seifert fibered.

Picture 5.2.

Picture 5.3.
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Picture 5.4.

Picture 5.5.

Picture 5.6.
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Theorem 4.2 (Seifert fiber space conjecture [8, 4]). Let M be an irreducible 3-manifold with infinite �1. Then M is
Seifert fibered if and only if �1ðMÞ has an infinite, cyclic, normal subgroup.

In our situation we need only a partial solution of the Seifert fiber space conjecture settled by Waldhausen [29],
Gordon–Heil [11], see also Jaco–Shalen [15].

From Lemma 4:1, we see that c1 is a fiber in some Seifert fibration of ðK;�1Þ.
Furthermore by assuming that ðK;�1Þ is a Seifert fiber space over S2 with three exceptional fibers of indices 2, 3 and

7, the presentation suggests that the exterior ðK;�1Þ � intNðc1Þ is a Seifert fiber space over the disk with two
exceptional fibers of indices 2, 3, and hence the index of c1 is 7. We will give a proper proof of these facts in
Proposition 4:3.

Recall that ðK;�2Þ (resp. ðK;�3Þ) is a Seifert fiber space over S2 with three exceptional fibers of indices 2, 4 and 5

(resp. 3, 3 and 4).
(7) Applying the same method as (4)–(6) above for r ¼ �2;�3, we have:

These suggest that c1 becomes an exceptional fiber of index 5 in ðK;�2Þ, and that c1 becomes an exceptional fiber
of index 4 in ðK;�3Þ.

Now we give a proper proof of:

Picture 5.7.

Picture 5.8.
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Proposition 4.3. For the figure-eight knot K, ðK;�1Þ is a Seifert fiber space over S2 with three exceptional fibers of
indices 2, 3 and 7, and the trivial knot c1 in Fig. 4:1 becomes an exceptional fiber of index 7.

Proof of Proposition 4:3. The sequence in Fig. 4:2 shows that ðK 0; 1Þ ¼
 ðK;�1Þ where K 0 is the left handed trefoil.
Follow the sequence backward. We then see that c1, a trivial knot in S

3 disjoint from K [Fig. 4:2(d)], can be regarded as
a meridian of K 0 when identifying ðK;�1Þ with ðK 0; 1Þ [Fig. 4:2(a)].

Recall that EðK 0Þ is a Seifert fiber space over the disk with two exceptional fibers of indices 2, 3, and that the fiber
slope on @EðK 0Þ is �6. Since the minimal geometric intersection number of the fiber slope �6 and the surgery slope 1 is
7, we can extend the Seifert fibration of EðK 0Þ to that of ðK 0; 1Þ so that the core of the reglued solid torus is an
exceptional fiber of index 7. Thus ðK 0; 1Þ is a Seifert fiber space over S2 with three exceptional fibers of indices 2, 3 and
7. Furthermore, since the surgery slope on K 0 is an integer, a meridian of K 0 is a longitude of the reglued solid torus.
This implies that a meridian of K 0 is isotopic to the core of the reglued solid torus in ðK 0; 1Þ, i.e., the exceptional fiber of
index 7.

Hence, after isotoping the fibration slightly, the trivial knot c1 � S3 disjoint from K becomes an exceptional fiber of
index 7 in ðK;�1Þ. �

Next we consider c2 instead of c1.

SnapPea Experiment 6 (Seifert fibered surgeries on the figure-eight knot II)
(1) Applying the same method in SnapPea Experiment 5, we have Pictures 6:1, 6:2 and 6:3.

These suggest that c2 becomes an exceptional fiber of index 7 in ðK;�1Þ, an exceptional fiber of index 4 in
ðK;�2Þ and an exceptional fiber of index 3 in ðK;�3Þ.

Here we prove these facts only in the case where r ¼ �1.

Proposition 4.4. For the figure-eight knot K, ðK;�1Þ is a Seifert fiber space over S2 with three exceptional fibers of
indices 2, 3 and 7 and the trivial knot c2 in Fig. 4:1 becomes an exceptional fiber of index 7.

K figure-eight knot

c1

-1

c1
-1

1

1

-1

c1

c1

1

K’ trefoil knot

(a)

(b)

(c)

(d)

Fig. 4.2.
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Picture 6.1.

Picture 6.2.

Picture 6.3.
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Proof of Proposition 4:4. Consider the sequence in Fig. 4:3 and apply a similar argument in the proof of
Proposition 4:3. �

To sum up we have:

S3 ðK;�1Þ ðK;�2Þ ðK;�3Þ
c1 unknot fiber of index 7 fiber of index 5 fiber of index 4

c2 unknot fiber of index 7 fiber of index 4 fiber of index 3

These examples lead us to the following conjecture, which answers Question 1.

Conjecture 4.5 ([22]). Let K be a knot in S3. If ðK; rÞ is a Seifert fiber space, then it admits a Seifert fibration such
that a fiber of it is unknotted in (the original) S3.

In [22, Section 6] we verified this conjecture for some Seifert fibered surgeries on the following knots:
. 2-bridge knots,
. Eudave-Muñoz’ hyperbolic knots with non-hyperbolic surgeries [6], and
. Some twisted torus knots.
Recently, in [7], Eudave-Muñoz introduced new infinite families of hyperbolic knots admitting Seifert fibered

surgeries and verified Conjecture 4:5 for these families. More recently, Mattman, Miyazaki and myself [19] discovered
infinite families of knots each of which admits a Seifert fibered surgery with none of these surgeries coming from
Dean’s primitive/Seifert-fibered construction, for the definition of primitive/Seifert-fibered construction, see [5, 10].
These families give a negative answer to [10, Conjecture 4.6]. However these Seifert fibered surgeries satisfy
Conjecture 4:5.

Here is another important conjecture which is still open, see [10].

c2

K1

K1

K’1

K1

K1

K2

K2

K2

K2

K’2

c2 c2

c2 c2

c2 c2

K’2

=

trefoil knot

figure-eight knot

1

-1

-1

1

1

-1

1

-1

1

-1

-1

Fig. 4.3.
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Conjecture 4.6. If ðK; rÞ ðr 6¼ 1
0
Þ is a Seifert fiber space, then either r is an integer, or K is a trivial knot, a torus knot

or a cable of a torus knot.

In [22], we proved:

Theorem 4.7 ([22]). Suppose that ðK; rÞ ðr 6¼ 1
0
Þ is a Seifert fiber space. If the surgery satisfies Conjecture 4:5, then it

satisfies Conjecture 4:6.

Remark. Hayashi [12] and Hayashi–Motegi [13] also obtained some weaker results under some assumption of the
position of fibers.

5. Closed Geodesics and Seifert Fibers

Let K be a hyperbolic knot in S3. Suppose that the hyperbolic structure of S3 � K degenerates to a Seifert fibering
structure of ðK; rÞ. In the previous section we consider the question: Which curves in S3 � K become fibers in ðK; rÞ?
Conjecture 4:5 states that we can always find a trivial knot as the candidates for such curves. Experiments via SnapPea
suggest that some closed geodesics in the hyperbolic manifold S3 � K can be candidates for such curves.

We start again with Seifert fibered surgeries on the figure-eight knot K. Let c1 and c2 be the trivial knots in S3 � K

depicted in Fig. 4:1.

SnapPea Experiment 7 (c1 is the shortest closed geodesic)
Let us check that c1 is a shortest closed geodesic in the complement of the figure-eight knot.

(1) Following SnapPea Experiment 5 (1), (2), we have Picture 5:2, in which SnapPea shows that the complement of
the figure-eight knot is hyperbolic.

(2) To get a list of closed geodesics, choose Length Spectrum in View menu (Picture 7:1).

Then we have the ‘‘Length Spectrum’’ window as in Picture 7:2. The important parameter is the ‘‘Find geodesics
to length’’ box. SnapPea will compute and report all geodesics up to the cutoff length we specify here. In
Picture 7:2, we put the number 2 in the box so that SnapPea finds geodesics up to length 2 in the complement
S3 � K.
By clicking Compute button, SnapPea provides us the list of closed geodesics up to length � 2 (Picture 7:3).
The table in the ‘‘Length Spectrum’’ window shows that there are two shortest closed geodesics having the same
length 1:087 . . . and distinct torsions 1:722 . . . and �1:722 . . .. (These closed geodesics are related by an
orientation reversing isometry of S3 � K.)

(3) We choose Core Geodesics in View menu (Picture 7:4).
Then SnapPea shows that the c1 has length 1:087 . . . (Picture 7:5). Referring the list in the ‘‘Length Spectrum’’
window, we see that c1 is a shortest geodesic in S3 � K.

Picture 7.1.
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Picture 7.2.

Picture 7.3.

Picture 7.4.
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SnapPea Experiment 8 (c2 is the second shortest closed geodesic)
Applying the same procedures in SnapPea Experiment 7, we have Picture 8:1.

This shows that c2 is the second shortest geodesic in the complement of the figure-eight knot.

Remark. Recently Miller [20] studies geodesic knots in the figure knot complement in detail.

SnapPea Experiments 7 and 8 suggest that short closed geodesics in hyperbolic knot complements often serve as c in
Question 1. We give more examples of this kind.

Example (twist knots). Let K2;2n be the twist knot and c the trivial knot described in Fig. 5:1.

It is known that K2;2n is hyperbolic for n 6¼ 0; 1. As shown in [22, Proposition 6.1], ðK2;2n; rÞ is a Seifert fiber space
with c an exceptional fiber in ðK2;2n; rÞ, where r ¼ �1;�2;�3. Note that K2;0 [ c is the Whitehead link, and K2;2n is
obtained from K2;0 by performing �1=n-surgery on c. From Thurston’s hyperbolic Dehn surgery theorem [27, 28], c is
the unique shortest geodesic in S3 � K2;2n if jnj is sufficiently large, and the length of c tends to 0 as jnj ! 1. This
result, together with tests by SnapPea for small n, suggests that c is the shortest geodesic in S3 � K2;2n for any n 6¼ 0; 1.

SnapPea Experiment 9 (Seifert fibered surgeries on twist knots)
Here we apply the method which was given in Sect. 3 to check that c in Fig. 5:1 is a shortest closed geodesic in

Picture 7.5.

Picture 8.1.
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S3 � K2;10 and c becomes a fiber in ðK2;10;�3Þ. Note that K2;10 is obtained from K2;0 by 5-twisting about c.
(1) Draw a diagram of the Whitehead link K2;0 [ c and fill in the meridian-longitude boxes in the second row with 1

and �5 respectively to obtain K2;10, see SnapPea Experiment 3. After clicking Recompute button, we have
Picture 9:1, in which SnapPea shows that K2;10 is a hyperbolic knot with hyperbolic volume 3:553 . . ..

(2) Apply the procedure as in SnapPea Experiment 7 (2), we have Picture 9:2, in which SnapPea shows that there is a
unique shortest closed geodesic of length 0:070 . . . in S3 � K2;10.

(3) Choose Core Geodesics in View menu, we have Picture 9:3, in which SnapPea shows that c is the shortest closed
geodesic in S3 � K2;10. (Compare the length of the shortest geodesic in the ‘‘Length Spectrum’’ window and the
length of the core geodesic.)

Let us check that c becomes a fiber in the Seifert fiber space ðK2;10;�3Þ. To recognize that ðK2;10;�3Þ is, in fact,
Seifert fibered, we need a proper proof as in [3], see also [22]. Here we appply SnapPea Experiment 4 to observe that
ðK2;10;�3Þ is non-hyperbolic.
(4) Note that the linking number of K2;0 (the red component) and c (the blue component) is zero. The correct surgery

coefficient p
q
¼ �3� 5� 02 ¼ �3, see Proposition 3:1. Thus to perform �3-surgery on K2;10, we fill in the

meridian-longitude boxes in the first row with �3 and 1 respectively as in Picture 9:4. Clicking Recompute
button, we have a message suggesting that the result is not hyperbolic.

(5) Following the procedures in SnapPea Experiment 5 (4)–(6), we have Picture 9:5.
This suggests that c becomes a fiber in ðK2;10;�3Þ.

Exercise. Get a feel that the length of c in S3 � K2;2n tends to 0 as jnj ! 1 by applying SnapPea Experiment 9 (1)
and (3).

SnapPea Experiments 7 and 9 lead us to more specific question.

n-twist

K2,2n

c

Fig. 5.1.

Picture 9.1.
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Picture 9.2.

Picture 9.3.

Picture 9.4.
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Question 2. Suppose that K is a hyperbolic knot in S3, and ðK; rÞ is Seifert fibered. Then does a ‘‘shortest closed
geodesic’’ c in S3 � K satisfy that:

. c is a trivial knot in S3, and

. c is a fiber in some Seifert fibration of ðK; rÞ?

In [22, Example 3], we investigated surgeries on Eudave-Muñoz’ hyperbolic knots and gave another supporting
evidence of the positive answer to this question. However, the following example demonstrates that Question 2 is
negative in general. It should be mentioned that in the example, instead of the shortest closed geodesic, the second
shortest one satisfies the condition in Question 2.

SnapPea Experiment 10 (Seifert fibered surgery on a twisted torus knot)
Consider a link depicted in Picture 10:1; the red component K is a ð3; 7Þ-torus knot. Let K�1 be a knot obtained from

K by ð�1Þ-twisting about the blue component c. The linking number of K and c is 10. The knot K�1 is referred to as the
twisted torus knot Kð3; 7; 10;�1Þ [22] and [23], see also [5] for twisted torus knots of distinct types.

(1) To obtain the twisted torus knot K�1 ¼ Kð3; 7; 10;�1Þ using the method in Sect. 3, we perform 1-surgery on c

and click Recompute button, see Picture 10:2.
SnapPea shows that the twisted torus knot Kð3; 7; 10;�1Þ is a hyperbolic knot with hyperbolic volume 6:128 . . ..
In fact, applying the argument in [23], we can show that K�1 ¼ Kð3; 7; 10;�1Þ is hyperbolic.

Picture 9.5.

Picture 10.1.
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(2) Perform �79-surgery on K�1. Since the linking number of K and c is 10, the correct surgery coefficient
p
q
¼ �79� ð�1Þ � 102 ¼ 21 (Proposition 3:1). Hence to perform �79-surgery on K�1, we fill in the meridian-

longitude boxes in the first row with 21 and 1 respectively as in Picture 10:3. Clicking Recompute button to get
an information about ðK�1;�79Þ, we have a message suggesting that the result is not hyperbolic.

Moreover, by choosing Fundamental Group in View menu, we have Picture 10:4 in which SnapPea shows that
�1ððK�1;�79ÞÞ ¼
 Z79. This then suggests that ðK�1;�79Þ is a lens space.
For a proper proof of this, see [22, Proposition 6.4].

(3) As in SnapPea Experiment 7 (2), we have Picture 10:5 in which SnapPea reports all geodesics up to length 1.
(4) To drill out the shortest geodesic, choose Drilling in View menu (Picture 10:6).
(5) Then we have the ‘‘Drilling’’ window which offers a selection of closed geodesics. We select the shortest closed

geodesic in the window by clicking (Picture 10:7) and then click Drill button (Picture 10:8).
Then we have a new ‘‘Dehn filling’’ window in which the new cusp is added to the end of the manifold’s cusp list
(Picture 10:9)

(6) To check whether the curve we have drilled is isotopic to the intended geodesic, perform a 1
0
-Dehn filling to

restore the original hyperbolic structure (Picture 10:10).
(7) Consider the complement S3 � ðshortest closed geodesicÞ, which can be obtained as ðK�1;

1
0
Þ � ðthird

componentÞ. To get this manifold we fill in the meridian-longitude boxes in the first row with 1 and 0

Picture 10.2.

Picture 10.3.
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Picture 10.4.

Picture 10.5.

Picture 10.6.
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Picture 10.7.

Picture 10.8.

Picture 10.9.
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respectively (the meridian is not changed under twisting about c) and delete 1, 0 from the third row as in
Picture 10:11. Clicking Recompute button, we have a message which suggests that the complement of the
shortest closed geodesic in S3 is not hyperbolic (Picture 10:11).

(8) Check the fundamental group of the complement of the shortest closed geodesic in S3. Choose Fundamental
Group in View menu to get a presentation.
In Picture 10:12, SnapPea gives the presentation of �1ðS3 � ðshortest closed geodesicÞÞ:

�1 ¼ ha; b j a2b3i:

Applying the argument in SnapPea Experiment 5 (6), we see that the exterior S3 � intNðshortest closed geodesicÞ
is Seifert fibered with the above fundamental group, and hence that the shortest closed geodesic is a trefoil knot in
S3.

(9) Let us see that the shortest closed geodesic becomes a fiber in ðK�1;�79Þ. Apply a similar method, we have
Picture 10:13, in which SnapPea shows that �1ððK�1;�79Þ � intNðshortest closed geodesicÞÞ ¼
 �1ððK�1;

�79Þ � ðshortest closed geodesicÞÞ ¼
 Z.
It turns out that ðK�1;�79Þ � intNðshortest closed geodesicÞ is a solid torus and the shortest closed geodesic
becomes a fiber in ðK�1;�79Þ. More precisely, the shortest closed geodesic becomes a core of a genus one

Picture 10.10.

Picture 10.11.
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Heegaard splitting of the lens space ðK�1;�79Þ.
Thus in this example, the shortest closed geodesic becomes a fiber in ðK�1;�79Þ, but it is nontrivial in S3.
However, the second shortest closed geodesic in the complement S3 � K�1 is trivial in S3 and becomes a fiber in

ðK�1;�79Þ, see Exercise below.

Exercise. We use a symbol c to denote also the image of c (the blue component) in ðc; 1Þ and ðK�1;�79Þ.
. Check that c in S3 � K�1 is the second shortest geodesic.

Hint: In Picture 10:5, choose Core Geodesics in View menu to get the length of the core geodesic (i.e., the core c
of the reglued solid torus), and compare the length in the table in the ‘‘Length spectrum’’ window.
Since the original c is trivial in S3, after 1-surgery along c, the image c is still trivial in S3. Hence the second
shortest geodesic c is trivial in S3.

. Check that the second shortest geodesic c becomes a fiber in ðK�1;�79Þ.
Hint: Delete 1, 1 from the second row in Picture 10:3 and click Recompute button to get an information about
ðK�1;�79Þ � c. Then check �1ððK�1;�79Þ � cÞ by choosing Fundamental Group in View menu.
For a proper proof of this, see [22, 6.3].

Keeping the above example in mind, we propose:

Picture 10.12.

Picture 10.13.
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Question 3. Suppose that K is a hyperbolic knot in S3 and ðK; rÞ is Seifert fibered. Is there a closed geodesic c in
S3 � K such that:

. c is unknotted in S3, and

. c is a fiber in some Seifert fibration of ðK; rÞ?

Question 4. Suppose that K is a hyperbolic knot in S3 and ðK; rÞ is Seifert fibered. Then does there exist a shortest
geodesic in S3 � K which is a fiber in some Seifert fibration of ðK; rÞ? In particular, is a shortest geodesic in S3 � K a
trivial knot or a torus knot viewed in the Seifert fiber space S3 ¼ ðK; 1

0
Þ?

Remark. We can check by SnapPea that shortest geodesics in S3 � K are unknotted in S3 for any hyperbolic knot K
with up to 11 crossings.

SnapPea Experiment 11 (Seifert fibered surgery on ð�2; 3; 7Þ-pretzel knot I)
Let K be the ð�2; 3; 7Þ-pretzel knot, see Picture 11:1. It is shown in [2, p.1043] that ðK; 17Þ is a Seifert fiber space

over S2 with three exceptional fibers of indices 2, 3, 5. (In the following we assume this fact.)

(1) Following SnapPea Experiment 10 (3)–(5) we drill out a shortest closed geodesic and we have Pictures 11:2 and
11:3.

(2) To check whether the curve we have drilled is isotopic to the intended geodesic, perform a 1
0
-Dehn filling to

restore the original hyperbolic structure (Picture 11:4).
(3) Apply the method in SnapPea Experiment 10 (7), (8), we have Picture 11:5.

In Picture 11:5, the fundamental group of the complement of the shortest geodesic in S3 is isomorphic to Z. This
implies by the unknotting theorem [25] that it is unknotted in S3.

(4) Apply a similar method in SnapPea Experiment 5 (4)–(6), we have Picture 11:6 and conclude that the shortest
geodesic becomes a fiber in ðK; 17Þ.
Thus Question 2 is positive for 17-surgery on ð�2; 3; 7Þ-pretzel knot.

SnapPea Experiment 12 (Seifert fibered surgery on ð�2; 3; 7Þ-pretzel knot II)
We continue to study 17-surgery on ð�2; 3; 7Þ-pretzel knot K. Let us consider the fifth shortest geodesic c5 in S3 � K.

(1) Following SnapPea Experiment 11 (1)–(3), we have Pictures 12:1 and 12:2. Here we select the fifth shortest
closed geodesic in the ‘‘Drilling’’ window in Picture 12:1. (In the ‘‘Drilling’’ window, the fourth shortest geodesic
is not offered to drill out.)
Since �1ðS3 � c5Þ ¼
 Z, by unknotting theorem [25], c5 is unknotted in S3.

(2) The structure of ðK; 17Þ � c5 is given by Picture 12:3.
In Picture 12:3, SnapPea shows that the complement ðK; 17Þ � c5 is hyperbolic, in particular, c5 cannot become a
fiber in any Seifert fibration of ðK; 17Þ.

Picture 11.1.
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Picture 11.2.

Picture 11.3.

Picture 11.4.

122 MOTEGI



Picture 11.5.

Picture 11.6.

Picture 12.1.
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